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BioActive research group
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* |dentification

» Characterization

+ Biological effects (neurological effects,
citotoxycity, oxidative stress,
antimicrobial activity

of biological active molecules with

potential applications in biotechnology.
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Main research subjects:

- molecular biology of pAO1 megaplasmid related to
nicotine catabolism, stress induced by nicotine
degradation and biotechnological applications.
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Latest paper:
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Impact of 3D-printed molecular models on student
d ding of ecul. a
compensatory research study
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- using 3D printing for creating teaching materials to support
molecular bioscience education.

Amylase  Amylopectin
from starch

e,

%
S,
*7‘\,

;‘s“w

Developed educational resources:

Modele fizice ale moleculelor pentru o
mai buna educatie in stiintele vietii

https://modelemoleculare.ro/
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The plan for today
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Theoretical part - This presentation

 Why are 3D printed molecular models needed?

« Are these models efficient?

« How and from where can | get 3D printed models ?

Hands-on part - the workshop
 .PDB to .STL files - software and steps
» Practical considerations when 3D printing molecular models

29.10.2025
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Understanding Life Sciences relies on understanding Structural Biology

ALEXANDRU IOAN CUZA UNIVERSITY of IASI www. uaic.ro
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Teaching Chemistry and Biochemistry relies on structural formulae
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a-D-glucopyranose
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Molecular models to aid teaching - Molymod
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http://www.molymod.com/MMS-004_Inorganic__Organic_Teacher_Set.jpg

molymod®

The original dual-scale system of molecular models
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Molecular models to aid teaching - DIY

www. uaic.ro

Styrofoam balls and copper wires
10.1021/ed066p1015

Flexible foam, wires and foam cut-outs
10.1002/bmb.2006.494034042649

Glass Beads
10.1021/ED200142G

10.1021/ed400126p
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Molecular models to aid teaching - Paper models

www. uaic.ro

P ISl Build a Paper Model of DN{‘\M . = oy

pdbioL.resb.org
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Antibody DNA Dengue Virus Green and Red
(Paper Model) (Paper Model) (Paper Model) Fluorescent Proteins
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Quasisymmetry in tRNA Zika Virus with and
Icosahedral Viruses (Paper Model) without antibodies
(Activity Page) (Paper Model)

https://pdb101.rcsb.org/learn/paper-models
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Molecular models to aid teaching - 3D printed models
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p53 tumor suppressor protein Human haemog|obin
10.1002/bmb.2006.494034042649 0.1021/acs.jchemed.5b00207 10.1063/1.4739961

Human deoxyhaemoglobin EcoRl endonuclease and DNA  Nanopore sequencing complex
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Molecular models to aid teaching - 3D printed models

www. uaic.ro

10.1021/acs.jchemed.2c00231

Custom macromolecular models, adapted to the teacher’s/demonstrator’s
requirements are needed !!!
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Custom macromolecular models for teaching are need it
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1
The custom macromolecular models should be:

Based on real /
scientific data

Depicted using
standardized

\/ L representati})ns: y

Easy to edit and adapt)

www. uaic.ro

224 572 to the outcomes of a
structures specific lesson;( Cheap to fabricate
f1 0?8 577‘|CI§IM l \,/ ’L and reproduce;
reely available (

SBPDBe  molecular visualization software Easy to distribute

Protein Data Banlcin Europe Chimera, Jmol, PyMol
PDB | \/ ‘
PDBJ 3D printing can do that
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What is 3D printing?

*
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3D printing - construction of a three-dimensional object from a digital 3D model.
Also termed additive manufacturing.

Material extrusion / Fused filament fabrication (FFF) / fused deposition modeling (FDM)

Scopigno R et al. (2017). "Digital Fabrication
Techniques for Cultural Heritage: A
Survey". Computer Graphics Forum 36 (1): 6-21
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3D printing using FFF is accessible

ALEXANDRU IOAN CUZA UNIVERSITY of IASI

Under 5009 printers

Il Today's Deals CustomerService Marlus's Amazon.com BuyAgain Browsing History ~  Gift Cards

www. uaic.ro

20$ - 40S Kg of plastic

Hello, Ma...  Retums

B Recoumts Somes Yo

Amazon's response to COVID-19

1-16 of over 1,000 results for "pla”

Department
3D Printing Supplies
3D Printing Filament
Movies & TV
Movies & Films
Prime Video
TV Shows
v See All 6 Departments

Avg. Customer Review
V' &Up
I &Up
‘&Up
Y7 &up

Brand

() HATCHBOX
[Jsunwy

[Z) overTURE
[] TecBEARS
(213D Solutech
[ MikazD
[esun

~ See more

3D Printing Materials

[ aBs

[CJHips

[_] peTe

[JpLa

[Jpva

[ Wood-Plastic Composite

3D Printer Filament Weight
[uptoagag
[[1500t0999 g
[T1to1.9kg

[ 2 kg & above

From Our Brands
["J our Brands

Packaging Option
[ Frustration-Free Packaging

ovE

RTURE

Sort by: Featured v

Sponsored @

TECBEARS PLA 3D Printer Filament 1.75mm Black,
Dimensional Accuracy +/- 0.02 mm, 1 Kg Spool, Pack of 1
Fodkoddedr v 4,769

$1999

Save more with Subscribe & Save

Ships to Romania

Sponsored @

OVERTURE PLA Filament 1.75mm with 3D Build Surface
200mm x 200mm 3D Printer Consumables, 1kg Spool...
Aiffrr v 6,128

$20%9 ($1.05/10 Items)

Save more with Subscribe & Save

Ships to Romania

HATCHBOX PLA 3D Printer Filament, Dimensional
Accuracy +/- 0.03 mm, 1 kg Spool, 1.75 mm, Black, Pack...
Fokedekoly v 11,192

52299

Ships to Romania

More Buying Choices

$21.50 (9 used & new offers)

OVERTURE PLA Filament 1.75mm with 3D Build Surface
200mm x 200mm 3D Printer Consumables, 1kg Spool...
Fok A kode ¥ 6,129

$22% ($1.15/10 Items) $25:99

Save more with Subscribe & Save

Ships to Romania

More Buying Choices
$18.99 (17 new offers)

3D printing can pe used in high schools/universities from low-income countries to
fabricate macromolecular models adapted to teachers needs

29.10.2025
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Do these models make a difference in teaching?

ALEXANDRU IOAN CUZA UNIVERSITY of IASI www.uaic.ro

A compensatory research study

Laura Nicoleta P. Razvan Stefan B.

Week2 __________ [Week3 _____________ [Week4 -Week

Pre-test 1 Il;fcactt:ir:s1 - Post-test 1 Pre-test 2 Lecture 2 - Post-test 2
DNA structure
Structure
2 days
N(,z ti Intervention afte?
2 days before R days after 2 days before
Announcement lecture, .
Recruitment lecture, 30 lecture, 30  lecture, 30 30 Intervention and
C minutes, 13 minutes, 13  minutes, 10 . Feedback form
onsent . . . minutes,
questions Int ti questions questions No
ntervention intervention questions

The project was approved by the ethics committee at the Department of Phycology and Education Sciences, Alexandru loan Cuza University of lasi (no
186/29.01.2024). Students were informed prior to the start of instruction of the purpose and objectives of the investigation. Student participation was anonymous
and voluntarily, and each student was presented with the opportunity to exclude him/herself from the study at any time. Information regarding data security, the type
of information obtained, data storage procedures, and the measures taken to protect participants' anonymity was provided. Furthermore, students were assured that
participation would have no bearing on any score assignment and that the results could be used for publication.
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Do these models make a difference in teaching?

ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWw.uaic.ro
Evaluation of impact is key

_m Zs;e;i?:’nne;nt Learning objective Biomolecular visualization learning goals
U

Amino acids, peptides and proteins
4 amino acids (L-Glycine, L-
ryptophan, L-Proline, L-
Arginine) in different
representations

Recognize a variety of
10.60705/3dpx/21049.1 Q2, Q4 molecular representations (i.e.
stick and space fill).

AR2.02 students will describe the atoms that are
represented in different renderings. (novice)

Recognize a variety of
molecular representations (i.e.
stick and space fill). Identify

Q1, Q2, Q3, features of the peptide

Q4, Q7 backbone, including the amino
and carboxyl ends, peptide
bonds, and alpha carbon. N to
C direction

MR1.01 given a rendered structure of a biological
polymer students will be able to identify the
ends of a biological polymer. (novice, amateur,
expert)

MR1.02 given a rendered structure, students will
be able to divide the polymer into its monomer
units. (novice)

wo insuline chains (PDBID
4ins, chains C and D) in 4
TR T R AT 1| 19910, 60705/ 3dpx /210511
and sticks, cartoon and
surface

TC2.06 Students can identify the levels of
protein structure (e.g., parse a
Describe why and how protein tertiary/quaternary structure into a series of

hL_lman el laceebly 10.60705/3dpx/14895.2 Q10, Q11 subunits interact to make the secondary structures/motifs) and the ways in
ith removable hem

Quaternary structure of

“quaternary structure” which they are connected from a
three-dimensional structure. (Novice, Amateur,
Expert)
eyl e Elsu 2 fie REETS & VETEH O AR2.02 students will describe the atoms that are
ribonucleotides in in 10.60705/3dpx/21050.1 Q2, molecular representations (i.e. )

different representations. stick and space fill). FEUESENTEG] ln CAECKTENE [EeSES. (NeOEs)

AG3.01 Students can identify a dihedral/torsion

angle in a three-dimensional representation of a
B-DNA dodecamer printed in Understand the flexibility of = macromolecule. (Novice)

. P 10.60705/3dpx/14893.2 Q5 DNA due to the higher number AG3.02 Students can identify the planes between
lexible . . . . _
of rotable bonds. which a dihedral/torsion angle exists within a

three-dimensional representation of a
macromolecule. (Novice)

https://biomolviz.org/. Biochem Mol Biol Educ. 2017 Jan 2;45(1):69-75. doi: 10.1002/bmb.20991.
29.10.2025 Slide 16 / 46



https://biomolviz.org/

Results
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Individual learning gain

A HGroupA EGroupB
0,5 **— — *
0,4
- Medium-g lecture
€ 0,3 s B e R e
o Low-g lecture
C
©
0]
S 02
0,1
0
Lecture 1 Lecture 2

29.10.2025
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Average group score (%)
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Pre-test

*%

Control
Intervention

Group A Group B

Lecture 1

www. uaic.ro

M Post-test

*%

c
.9
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S
(]
e}
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Group A Group B

©
S
=y
c
o
(O]

Lecture 2

10.1002/bmb.21902
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Results
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Free-form assessment

A B
I would like more lectures/courses to I _ Cior ) T* ted
use 3D printed models. IS 't Functior l Connection
o ec ur e
| recommend that the 3D printed tructure Atoms
mosn o s o ns o yoor | N t Use rgved KHOW aitaz
lectures. oncep a S
_ T:Lme . J
T ttor amdorsrand the lorre . Y I F t Cl e
better understand the lecture. DNA Iniormation ear Vlsual

ttention
Tea:rned
0% 20% 40% 60% 80% 1009 UnderSt d ''''''' ite

. . anner M emor
B Strongly disagree mDisagree " Neutral mAgree B Strongly Agree d reaching

Boiangiu RS, Popa LN, Mihasan M. Journal of Science Education and Technology, submitted manuscript

“The 3D models were very useful as the information and images were
transformed into something physical that | could touch. And this helped me
better understand the content presented. It is easier to understand a notion or a
concept if one can hold it in its hand and turn it around to evaluated it from all
the angles”.

10.1002/bmb.21902
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Alternative ways of using 3D printed models in teaching

ALEXANDRU IOAN CUZA UNIVERSITY of IASI www. uaic.ro

Asking students to paint the models to recognize different structures

i R R T

o — — T




Alternative ways of using 3D printed models in teaching

ALEXANDRU IOAN CUZA UNIVERSITY of IASI www. uaic.ro

Guiding students to create and print their own models for presentations
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Bridging structural data to class content
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Hard learned truth:

Most teachers/students are very enthusiastic about
the models,

but verry few can/want to use structural data
and design models.

29.10.2025 Slide 21 / 46



Introducing 3DP-Jmol - a script for automatic generation

of 3D printable molecular models
ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW. uaic.ro

[ ] [ ] Jmol Script Console 16.3.7 2024-11-12 15:34

| 758 atoms selected

758 atoms selected

- Reading information related to the molecule: size, smallest and largest atom, smallest bond length
-~ Setting up 3D printing environment
32 hydrogen bonds

0 struts added

0 atoms selected

758 atoms selected

ballandstick 0 connections deleted

0 atoms selected

0 struts added

758 atoms selected

758 atoms selected

load =4BNA

opt

LigStruts = true

--- Start of 3D Printing RECOMMENDATIONS for single color/material ----

NucProtStruts Rendering and printing recommendations are provided for a medium size (ie. Ender 3; Prusa MK35+) FDM
-->Printed at a maximum allowed printing scale of 45 % , your model will be approx 210 mm x 124 mm x
. -->Printed at a minimum printing scale of 2 %, your model will be approx 11 mm x 6 mm x 7 mm.
PrintScaleFactorUser Your molecule is rather small. All styles are suitable and can be printed.

When deciding on the final dimensions and the corresponding scale, please keep in mind that:

- the minimum allowed scale for the Ball and stick style is 32 %;

-- the minimum allowed scale for the Trace style is 23 %;

--- the minimum allowed scale for the Ribbon style is 17 %;

----the minimum allowed scale for the Backbone style is 16 %;

————— The surface rendering can be as low as 2 % . Printing at smaller scales might still be possible, but at
--- End of 3D Printing RECOMMENDATIONS for single color/material ----

colorPrinter = 'no Printed at the curent scale/user selected scale of 34 %, your model will be approx 155 mm x 92 mm x 105
OK 18233684 Stl /Users/mariusmihasan/test.stl

Time for running the script version alfal.public: 5062ms

%

4] Il I [»]

Editor ‘ Font ‘ Clear | History State ‘ Undo | Redo Close Variables | Help

[T

3DP-Jmol
Development of 3DP-Jmol is supported by EDUMOL3D, Project PN-1V-P7-7.1-PED-2024-0343 financed by the Ministry of Research, Innovation and Digitization, UEFISCDI, Romania.
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Introducing 3DP-Jmol - a script for automatic generation

of 3D printable molecular models
ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW. uaic.ro

Make file for 3D printer

User options:

« Ulinclude H atoms

« PDBID: 4ins

« Style: OBall & Stick © Backbone (protein/nucleic) © Trace (protein/nucleic) ® Ribbon (protein/nucleic) © Cartoon (protein) O Blocks (nucleic)

Spacefill © Solvent-accesible surface © Molecular surface

. Ligands d to lecule. (Recc ded for backbone, trace or ribbon. Disabled for surfaces)

+ [ICreate support links (struts) between protein and nucleic chains.

« Size of printed model: 0.2
This should be 0 when first running the script to generate a model printable at the maximum size. Based on the feedback from the console, smaller
scales could be selected by users based on their preference. Scale in the console is %, but here it should be divided by 100. For example, enter 0.3
here for a scale of 30%.

« [Prepare for color printing.
Very experimental. A decision is needed here if required to implement. If checked, output will be 083 and color, if not, output will be STL and
monochrome. OBJ files are nor properly scaled yet, but can be done.

Undatd: 20250228, 102100002
Angel Herraez

University of Alcala,

Madrid, Spain

- Start of 3D Printing RECOMMENDATIONS -

Rendering and printing recommendations are provided for a medium size (ie. Ender 3; Prusa MK3S+) FDM 3D
printer. Using SLA printers is possible, but not yet tested.

-->Printed at a maximum allowed printing scale of 40% , your model will be approx 210 mm x 202 mm x 108
mm.

-->Printed at a minimum printing scale of 3% , your model will be approx 16 mm x 15 mm x 8 mm.

Your molecule is medium-sized. All styles except Ball and Stick can be printed.

When deciding on the final di ions and the corresponding scale, please keep in mind that:

- the minimum allowed scale for the Ball and stick style is 48%;

-- the minimum allowed scale for the Trace style is 23%;

--- the minimum allowed scale for the Ribbon style is 17%;

- the minimum allowed scale for the Backbone style is 16%;

----- The surface rendering can be as low as 3%. Printing at smaller scales might still be possible, but atomic
details (H atoms) will be lost.

-- End of 3D Printing RECOMMENDATIONS ---

Printed at the current scale/user selected scale of 20% , your model will be approx 105 mm x 101 mm x 54
mm.

\ J

Help:
STL file viewers: online :: ModuleWorks STLView :: Cravesoft STL Viewer

WRL file viewers: online :: FreeWRL TasksBoard | Desktop ap

https://biomodel.uah.es/JSmol2/Marius_Mihasan/PDB2STL.htm

3DP-Jmol
Development of 3DP-Jmol is supported by EDUMOL3D, Project PN-1V-P7-7.1-PED-2024-0343 financed by the Ministry of Research, Innovation and Digitization, UEFISCDI, Romania.
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3DP-Jmol - integration with Proteopedia

ALEXANDRU IOAN CUZA UNIVERSITY of IASI

PROTEOPEDIA

o | G | ‘o o | iy || v - - ‘ - LIFE IN 3D
Journal of Biological Inorganic Chemistry Apublication of the Please choose the parameters to tailor the aspect of the resulting printed model on page Journal:JBIC:2

Society of Biological Inorganic Chemistry

Half ich Complex Scheme | Proteopedia Scene V|

of i ium F
Bound to Glycogen Synthase Kinase 38
G. Atilla-Gocumen, L. Di Costanzo, E. Meggers I'!

Molecular Tour
Acrystal structure of an organometallic half-sandwich ruthenium complex bound to
the protein kinase glycogen synthase kinase 38 (GSK-38) has been determined (PDB
entry 3m1s) and reveals that the inhibitor binds to the ATP binding site via an induced fit
mechanism utlizing several hydrogen bonds and hydrophobic interactions.
Importantly, the metal is not involved in any direct interaction with the protein kinase but
fulflls a purely structural role. The unique, bulky molecular structure of the half-sandwich
complex with the CO-ligand oriented icular to the pyri

allows the complex to stretch the whole distance sandwiched between the faces of the
N-and C-terminal lobes and to interact tightly with the flexible glycine-rich loop.
Although this complex is a conventional ATP-competitive binder, the unique shape of the
complex allows novel interactions with the glycine-rich loop which are crucial for binding
potency and selectivity. It can be hypothesized that coordination spheres which present
other ligands towards the glycine-rich loop might display completely different protein

kinase selectivities. spin ) quaity abels @ 9 6
PDB reference: Structure of Ruthenium Half-Sandwich Complex Bound to Glycogen Make printer ﬂles
PDB ID 3rec )

Synthase Kinase 3, 3m1s.
References > Drag the structure Wiih the mouse toffotate
« PR - . . Export Animated Imadp PrintaD

Printer | Multimaterial/Multicolor v/

Printer scale |32 }% You may set from 2% to 32%. With the current scale, your model will be
approximately (x,y,z) e 192 x 210 x 194 mm.

Note: Before processing, we removed from the structure solvent (UREA, SO4, PO4, HOH, DOD, WAT),

Proteopedia Page Contributors and Editors (whatis this?)

1 NA K,CL,BR,GOL,DIO,DOX,NO,NO3,EDO,DMS,FMT,ACT,IPA, and they will not appear on the printed
model.

David Canner, Alexander Berchansky, Jaime Prilusky

This page complements a publication in scientific journals and is one of the Proteopedia’s Interactive 3D Complement pages. For aditional details please
see 13DC.

Page: | Journal:JBIC:2
Scheme: scene
Scale: 32%
Ligand struts: true
Nucleic acids struts: true
[ Download Files H Download SCRIPT 3
- [
With these OBJ and MTL files, your printer will generate a
Scene model of Journal:JBIC:2

9 The size of your model will be approximately
(x,y,z) 192 x 210 x 194 mm.

Generate files for the | Same structure ‘;with different

parameters.

«» Drag the model with the mouse to rotate

Programming and implementation by Jaime Prilusky. & STL/OBJ/MTL files generated with Jmol and 3DP-Jmol. > Model 3DP_J mol
preview powered with Online 3D viewer

Development of 3DP-Jmol is supported by EDUMOL3D, Project PN-IV-P7-7.1-PED-2024-0343 financed by the Ministry of Research, Innovation and Digitization, UEFISCDI, Romania.
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Summary

ALEXANDRU IOAN CUZA UNIVERSITY of IASI www.uaic.ro

*i;*

models of (macro)molecules improves learning outcomes

3D printing a cheap way of fabricating and distributing molecular models

Allowing students 3-5 minutes to handle
models converted a low-g lecture into a medium-g lecture.

Workflows are available

29.10.2025 3DP-Jmol Slide 25 / 46
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% Biochemistry students
Class 2022 - 2025 and 2023-2026
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Updates and new printed models
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Home About Jobs More =

About

L)

o

The group is based at the Faculty of
Biology, Alexandru loan Cuza University
of lasi, Romania. It consists of several
academia members and researchers,
technicians as well as students and
Ph.D's which share commaon research
interests.

The group is based at the Faculty of
Biology, Alexandru loan Cuza University
of lasi, Romania. It consists of several
academia members and researcher... See
More

513 people like this including 38 of your
friends

2 30 IR Y-

521 people follow this

http://wwiw.bio.uaic.rofcercetare/grupuri/
bicacti ontent/people/people. html

0232 201102

Send Message

Science Website

See All

Identification and
Characterization of
Biological Active Molecules

@BioActive.bio.uaic.ro -

[4 bio.uaic.ro

il Liked © Message Q e ‘ -

‘ Create Post
[ ]

lag Photo/Video o Check in ;‘ Tag Friends

PINNED POST

Identification and Characterization of Biological Active
TE Molecules
March 9 at 2:09 PM - @

Ever wondered how an antibedy looks like? Now you can print your

own molecular model of an antibody using a 3D printer. Instructions
and printable files available at https://3dprint.nih.gov/discover/3DPX
015554 Details in the molecule are available at

https://pdb10t.resb.org/motm/21
/

V-ati Intrebat cu arat3 n realitate un anticorp? Acum poate vizualizat
si manipulat sub forma unui medel tip&rit la imprimanta 3D!
Modelele tridimensionale gata de tiparit pentru doi anticer... See
More

Find us on Facebook @BioActive.bio.uaic.ro

@ Contact Us

www. uaic.ro
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A Practical Introduction to 3DP-Jmol

and 3D Printing

3
3
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1

Marius Mihasan, php.

Faculty of Biology

Alexandru loan Cuza University of lasi, Romania
E-mail: marius.mihasan®uaic.ro
https://github.com/mariusmihasan/3DP-Jmol
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How difficult it is to create your own 3D printable molecular model?

Let’s walk through the process together, and judge yourself
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3D printed models - how to get them

L]
% BIOLOGIC MODELS

The easy, but not necessarily the cheap way

Home Examples of our work FAQs Contact Us
[ Biologic Models
Custom 3D Printed Protein Models
Transform x-ray crystallography protein
into 30 Printed Biologic Models

SARS-CoV-2 Spike Protein
S jbmit Re u uest

https://biologicmodels.com/

jentists across an
printed the SARS-Cov-2 spike trimer for Prof.
/& been gifted to the

http:/ /www molecmodels co.uk/
P G N

T S e N R SO N
2 Sl kel a LI
= My Cart Help My Account

Program Lend Custom

Learn Shop

Custom Models Communicate Your Innovations

And Inspire Others

?
.
‘ N D

ORO)
https: //3dmolecularde512ns com
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The almost easy, but a bit cheaper way:

A1l. Find an already available model at:
https://3dprint.nih.gov/
https://modelemoleculare.ro/

OR

A2. Automatically create your own model with

Proteopedia Print3D tool
or

OR

A3. Ask somebody else to do it such as:
https://modelemoleculare.ro/product-
category/modele-la-cerere/

AND

3D printed models - how to get them

Generating printable files on Proteopedia
mol g,
. Ender3, o
imo imol 3 program.
axpor foatures.
Step-by-step guide for automatic generation of printable files on Proteopedia
Open a structure and access the Print3D tool
rolo, rtroduction 10 protoin snucture)

Select a molecular representation and a printing scale

Backbone, Trace, or Ribbon —

Surtace — 10 ighight molecula topoiogy and biing ses.

B & Stk —

This's
Hote:
Important!

(4) When roady, 3

Download the .STL or .0B files

PROTEOPEDIAN | MBidh, B0 "
——LIFE IN 3D— e e

Pl sop n gaarating ptate les

——
m‘uj Despre noi Cum obtinem modelele v Modele noi
LA

Modele fizice ale moleculelor pentru o
mai buna educatie in stiintele vietii

B. Fabricate your model using your own 3D printer or access an on demand 3D printing service
printari-3d.ro 3dp.ro fablab.ro
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What is 3D printing?

*
i?;;ff ALEXANDRU IOAN CUZA UNIVERSITY of IASI www.uaic.ro

3D printing - construction of a three-dimensional object from a digital 3D model.
Also termed additive manufacturing.

Material extrusion / Fused filament fabrication (FFF) / fused deposition modeling (FDM)

Scopigno R et al. (2017). "Digital Fabrication
Techniques for Cultural Heritage: A
Survey". Computer Graphics Forum 36 (1): 6-21
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Steps involving fabricating a macromolecular model

1 T
] )
% ALEXANDRU IOAN CUZA UNIVERSITY of IASI ‘ \4\ i
1. Chose or combine visualization styles;
Download structure from 2. Add H bonds or create struts to make
the model more Sturdy (mandatory for cartoon

%PDBe ;‘:f@%j RDBj and balls and sticks models, not required for surface); N

Freten Det Senk n Eueoe 3. Increase the thickness of each printed

PDB or CIF file element and/or improve the smoothness for ‘
molecular surfaces.

Visualize and prepare the model
in

LS i LRl ,// 1. Set the printing scale; =
2 2. Orient the model on printing bed;
STL file 1 3. Set printing resolution;
4. Set shell wall thickness and infill %;

5. Automatically add support;

6. Slice the model;

7. Send the resulting gcode to printer
(via SD-Card, USB or WiFi)

B. Print the model

GCODE file 1

Print

Support material

removal l

C/Clean up and finalize the physical/niodel

T E—————————y ]

10.37912/%511972;01?051 002/bmb.21493



https://doi.org/10.3791/55427
https://doi.org/10.1002/bmb.21493

A. How to generate of the computer model (or .STL/.0BJ file)

ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW. uaic.ro
£
A1. Using Proteopedia and Print3D tool; rovoaion
= Main Page

= Table of Contents

- Navigate to https.//proteopedia.org/wiki/index.php/Main_Page © Structure Index
Alternatively, search in Google for “Proteopedia” to navigate to the link above = Random

= Recent Changes

u Hel
* Log-in with your username and password - Cookbook
search
* On the left side, locate the Navigation panel and hit Table of Contents l l
&l Search

Expand the folders and chose your molecule of interest. Alternatively, if you.
know already a PDB ID of interest, type it in the Search box.

The new page that opens has on the right-side a section
displaying a structure. Most, if not all pages in Proteopedia,
have such a Structure Section. The content of the Structure
Section can be modified by clicking in any on any of the
green links. The Structure Section is initially opened in
view only mode - recognhizable by the Display Interactive
Model button.

«? Drag the structure with the mouse to rotate
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A. How to generate of the computer model (or .STL/.0BJ file)
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 Click on the Display Interactive Model button to activate an extra set of controls, including
the Print3D tool. Clicking the Print3D will start the two-step interactive conversion process;

Please choose the parameters to tailor the aspect of the resulting printed model on page Ribose-5-phosphate_isomerase

Scheme Trace v

Hydrogen atoms | OFF v Recommended to be off unless you have particular reasons to have the hydrogen atoms shown
in the model. H atoms might be required when the model is represented as ball and sticks, or
when ligands are present. If not H atoms are not mandatory, keep in mind that keeping this
option on will increase the minimum scale at which the model can be printed.

Ligand struts ON ~ If ligands are to be connected with the macromolecule.

Printer Single Color/Material

Printer scale 256 % You may set from 23% to 25%. With the current scale, your model will be approximately (x,y,z)
&) 203x108 x 184 mm.

Make printer files

Note: Before processing, we removed from the structure solvent (UREA, SO4, PO4, HOH, DOD, WAT),
NA,K,CL,BR,GOL,DIO,DOX,NO,NO3,EDO,DMS, FMT,ACT,IPA, and they will not appear on the printed model.

« What, How and other tips at Print3D Help
« Browse our Gallery of 3DPrinted Models

()?pin' D quality | D labels @‘m

Ribose-5-phosphate isomerase A dimer complex with ribyffose-5-

phosphate, 3enw

Show: O Asymmetric Unit
O] Biological Assembly, QSbio confidence: ¢

«? Drag the structure wit|
Export Animated Imagé
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A. How to generate of the computer model (or .STL/.0BJ file)

ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW. Uaic.ro

Surface

Great for arguing the complementary of molecular shapes
Extremely easy to print without any processing
Works well also for large macromolecular complexes

Step one:

Please choose the parameters to tailor the aspect of the resulij
on page Ribose-5-phosphate_isomerase

Scheme |Ribbon v

Hydrogen atoms OFF v Recommended to be off unless you have
particular reasons to have the hydrogen atoms
shown in the model. H atoms might be
required when the model is represgs
and sticks, or when ligands 3
H atoms are not mandg#éry, keep in mind that d . . .
keeping this optjgrfon will increase the SB% eﬁg rgtS erggggéﬁt]%l]l %f é\/f\Hg'W? émwt%?lks for

@dle at which the model can be els tak lo 'ﬁe Cé?f%?{#k ond "g?u?ﬁ)& éase leave

m s takes 3 i
sialy RiotITS; Taf) b o é}ﬁ%P
. ) Q ;}/' .

. b e
Ligand struts ON v If ligands ape8 be connected with the N A\ \ L *fg
< poctolecie but takes mOpELARBIT MaPe/IN
e .@
0,

ic acids to the models.

Struts to conzkg‘g
eme is Surface. Can be

Should be off When the
on for all the otprs'cﬂg

L
-~
b -

£d as ball > 35

e 0ot Epfiding en (e awailatReIpHTEY; Clar tesdels can also

lly, larger is better
aller is faster, but
’s more difficult to

L3
ria
, fine details ntight be l%k ng!iis,l
@"I ale 25 % Yum You miﬁ:?fromﬂ‘% ;olzs.?t.)wnh the - Baibk.& Stick l l’\f”' l " f
current scale, your moadel will be . : t t . .
approximately (x,y,z)9203x108x184 A& %Egglea§¥ﬁ?]?8]§®19(lsﬁgl%cfalngs gF%?gg'?&)SSS] € size tor

o u and calcutlates the final dimension$’in mm. Adjust

based on the available printer Fof this exercise, the

< ese-processing, we removed from the structure
PO4, HOH, DOD, WAT),
NA,K,CL,BR,GOL,DIO,DOX,NO,NO3,EDO,DMS,FMT,ACT,IPA, and they will not £ P
appear on the printed model. the Makefps LIV

+ What, How and other tips at Print3D Help
» Browse our Gallery of 3DPrinted Models
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Step two:

2
o)

~f\’_/‘-\\

> Drag the model with the mouse to rotate

L

) Page:

‘ Ribose-5-phosphate_isomerase ‘

Scheme: backbone
Scale: 25%
Ligand struts: true

‘ Download Files

[ Download SCRIPT \

With this STL file, your
printer will generate a
Backbone model of the
Biological Assembly of
Ribose-5-
phosphate_isomerase
9 The size of your model will
be approximately

(x,y,z) 203 x 108 x 184 mm.

Programming and implementation by Jaime Prilusky.
with Jmol and 3DP-Jmol.

+ What, How and other tips at Print3D Help
+ Browse our Gallery of 3DPrinted Models

29.10.2025

Generate files for the

‘ Same structure ‘With different

parameters.
STL/OBJ/MTL files generated

Model preview powered with Online 3D viewer

A. How to generate of the computer model (or .STL/.0BJ file)

www. uaic.ro

Preview of the rendered model. Can be be rotated for a closer examination.

Applied setting for rendering the model. Please
note the scale in %. It is going to be needed in
downstream steps.

Finally download the files in your computer

If the model is not as expected, hit
this button to get back to Step One
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A. How to generate of the computer model (or .STL/.0BJ file)

ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW. uaic.ro
e §Jmol §Jsmol it Gyec, Erems: (i
A2 U . 3 D P J l d J l f'fl . thrrl]?l: tan ofper:\-so.urlce Jatvla vie\tm‘zrI fordcgllemilcalI structures in 3D
. Sl n g - m o a n m o O ] ne; Wi ‘eatures 1or cnemicals, crystals, materiais an lomolecules y

1. Download and unpack Jmol;
https://jmol.sourceforge.net/

~ ¥ JSmol is the HTMLS5 modality of
Jmol, able to be embedded into
web pages. All the functionality of
Jmol ne

Alternative molecular visualization programs that will
work but are not covered here:
1. ChimeraX - https://www.rbvi.ucsf.edu/chimerax/
2. PyMOL - https://www.pymol.org/ some extra steps in
CAD software are required
3. Molecular Maya -https://clarafi.com/tools/mmaya/ - o
the plugin is free, but the Maya software is not " oo 50 o compt ke s e 11 rcarg vt or et rct Hrch 202
4. Mol* - https://molstar.org/ .

mo out installation, ‘
evel a portable disk, but needs Java installed) ‘ "!"
jsmi ip , the package needed for implementing JSmol COMMUNITY CoMMUNITY m
in web pages (does not need Java) CHOICE L . FORGE »
Main project page (source code) for Jmol+JSmol at EPoRce EFORGE

SourceForge.
J(S)mol scripting documentation

(The JSmol library may take some
seconds to load. Please, wait and do
not reload the page in the meantime.)

2. Access and copy 3DP-Jmol code by:

- Access the 3DP-Jmol Hithub at https://github.com/mariusmihasan/3DP-Jmol
- Click on the file 3DP-Jmol.v.alfa1.public

- Select the whole text and copy it.

3. Open a text editor of your choice (Microsoft word works also) and paste the code. Edit the first lines as
indicated to select your molecule of interest and other relevant parameters. Read carefully and only edit the
lines indicated. Do not close the text editor window!!

4. Open the previously unzipped Jmol application and navigate in the menu to File>Console.... A new window
entitled Console will open;
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A. How to generate of the computer model (or .STL/.0BJ file)

T .
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k3

4. Copy the entire content of the text file edited in step 3 and paste it in the Console window using the Ctrl-V
keyboard combination (or Cmd+V for Mac);

5. Wait patiently until JMol generates your printable file. This should be signaled by the appearance of a text

similar to:
OK 20527284 Stl /Users/mariusmihasan/test.stl

Time for running the script version alfal.public is: 4956ms

6. Check the instructions in the Console and, if required, based on the indications and your choice, come back
to step 3 and repeat. The path for the test.stl file generated is indicated before the last line in the Console.
Print it and enjoy!

ece 4ins.pdb - INS
TSI G g SITa Py FCCoTITCITa G o Gre Prov i ToT o I

L.l- Edit Display View Tools Plugins Macros Help

ro File Edit Display View Tools Plugins Macros Help
= EA P F oS @ A (™ (eS8

o F@ P = [P g @ amx @ [-->Printed at a maximum allowed printing scale of 489 %, yol
-->Printed at a minimum printing scale of 25 %, your model v
Your molecule is rather small. All styles are suitable and can b
When deciding on the final dimensions and the corresponding
- the minimum allowed scale for the Ball and stick style for sii
-- the minimum allowed scale for the Ball and stick style wher
--- the minimum allowed scale for the Trace style is 230 %; |
ol ———-~- the minimum allowed scale for the Ribbon style is 170 % |
————— the minimum allowed scale for the Cartoon style is 150
————— the minimum allowed scale for the Backbone style is 16
—————— The surface rendering can be as low as 25 % . Printing
--- End of 3D Printing RECOMMENDATIONS for multimaterial,

er e Jmol Script Console 16.3.7 2024-11-1215:34

$

OK 22025583 Obj /Users/mariusmihasan/test_color.obj, 751 /Us
Time for running the script version alfal.public: 4007ms

$

‘ Editor Font Clear History State Undo Close Variables Help

Editor Font Clear History State Close Variables Help
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B. 3D Printing the computer generated model

1 i
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1. Download and install BambuStudio; Bambu Studio

Bambu Studio is an open-source, cutting-edge, feature-rich
. slicing software. It contains project-based workfiows,
L] " P P "
h ttp S . / / b al N b u la b . COI N / e N / down load / St Ud'l O systematically optimized slicing algorithms, and an easy-to-
use graphical interface, bringing users an incredibly smooth
printing experience.

Alternative slicer programs used to control 3D printers: B
1. Prusa Slicer - https://www.prusa3d.com/page/prusaslicer_424/

2. Ultimaker Cura - https://ultimaker.com/software/ultimaker-cura/
3. Slic3r - https://slic3r.org/

4. Simplify3D - https://www.simplify3d.com/ not free

& Bambu Studio (Mac)

Download the Linux version from GitHub, or check the
latest release notes

>

Choosing one or another depends on the printer one has available

2. Open BambuStudio and run the Configuration Wizard. Accept all the defaults, except for the printer
selection screen. Here make sure that only the BambulLab A1 mini printer is selected (not critical, but
helps).

3. Download the configuration bundle. Link in the e-mail from the organisers

https://drive.google.com/file/d/1YM3sqMOEYSa7XxrpmzS5EqOsNFwNfaT8/view

4. In BambuStudio navigate to Menu > File > Import > Import Configigs...
Point to the newly downloaded file .BBSCFG and hit Open

What we just did is to install the printer control software and configs required to run my printer
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4, Load the created .stl file - In BambuStudio navigate to Menu > File > Import > Import STL/3MF/STEP...

Point to the .stl file and hit Open

Set

f® © Prepare

$ Preview

(D Printer

. ' i
'
A

Bambu Lab X1 Carbon

1. Printer

Texture...

Diameter 0.4 Flow Standard

2o Device

@

Sync info

() Project Filaments + - B 8
L
2. Material a s :
L]
S Process (LT Objects Advanced @ = %

X Q

MM - cartoon - 0.20mm Standard @B... B
3 ° Quality Strength Speed Support Others
° £ Layer height
Print/process...
. Initial layer height 0.2 mm
Sett] n gs = Line width
Default 042  mm
Initial layer 0.5 mm
Outer wall 0.42
Inner wal Il 0.45
Top surface 042 mm
Sparse infill 0.45 mm
Internal solid infill 0.42 mm
Support 0.42
[£) seam

Seam position Neares! t
Smart scarf seam application
Scarf application angle 155
threshold
Scarf around entire wall
Scarf steps 10
Scarf joint for inner walls

Nuarrida filamant erarf caa m

29.10.2025

B. 3D Printing the computer generated model

ALEXANDRU IOAN CUZA UNIVERSITY of IASI

B3 Multi-device [E Project @ Calibration

PRBUEE| <

Select A1 mini

Select Bambu > PLA Basic

Select MM, cartoon,.....

www. uaic.ro

5. Hit Slice

S o ¢ =

Shd3g8bbeol &

250.00 | 25000 | 250.00 % v
95.85 6159 89.54 mm
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f® & Prepare < Preview

(=) Printer
Bambu Lab X1 Carbon
Diameter ~ 0.4
Project Filaments

B - Brasasic

Process (EET)) Objects

Texture...

23 Device

Sync info

Flow Standard

MM - cartoon - 0.20mm Standard @B...

Quality Strength Speed

£ Layer height
Layer height
Initial layer height

= Line width
Default
Initial layer
Outer wall
Inner wall
Top surface
Sparse infill
Internal solid infill

Support

[Z] seam

Seam position

Smart scarf seam application

Scarf application angle
threshold

Scarf around entire wall
Scarf steps

Scarf joint for inner walls

+-B 8
©
Advanced @
B X Q
Support Others
0.2 mm
0.2 mm
0.42 mm
05 mm
0.42 mm
045 mm
0.42 mm
0.45 mm
0.42 mm
0.42 mm
Nearest
155 2
10

29.10.2025

B. 3D Printing the computer generated model

<

[ Multi-device

Front

Slicing Result

Color Scheme Line Type

Line Type Time

B Inner wall 5mé5s
Outer wall 9m55s
Overhangwall  2m22s
Internal solid infill 5s
Top surface 40s
Bridge 4s
Gap infill 2m19s
Support 1h2m
Support interface 10m19s
Support transition 3m12s
Custom Tm2s
Travel 35m9s
Retract
Unretract

u Wipe

B Seams

Total Estimation

Total Filament: 1451 m
Model Filament: ~ 1.67m
Cost 1.10
Prepare time 7m15s

Model printing time: 2h12m
Total time: 2h20m

~  siic \plate

~  Export plate sliced file

Percent Used filament  Dispiay

4% 063 m
71% 077 m
17% 0.05m
<0.1% 0.00m
0.5% 003 m
<0.1% 001 m
17% 007 m
44.7% 11.67m
7.4% 093m
23% 024m
5.0% 011m
252%

43969
5069

191
2329
014g
001g
010g
0029
0229
35379
2829
0729
033g

www. uaic.ro
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Guidelines and more details are available

*
i?;;jf ALEXANDRU IOAN CUZA UNIVERSITMYMEL IASI o www.uaic.ro

2 Marius Mihasan _mytak _my proforences  my waichist _my conirbulions 109 out

userpage  discussion editthispage  history  move watch userpage | discussion editthis page | hisiory | move watch

User:Marius Mihasan/Print3D models gallery

< UserMarius Miasan

ML SIS er:Marius Mihasan/Print3D help

<UserMarius Minasan

PROTEOPEDIA Contents i) I’Rorrorml A Welcome to the Proteopedia gallery of 3D printed models
—LIFEIN3D— 1 Proteopedia and 3D Printing LrE 0
2 3D Printing 101»: an introduction to 3D printing Did you use the Print3D tool in Proteopedia to create a printable model?
2.1 Printer Typss: FOM vs. SLADLP Do you have pictures of the final 3D printed model of a molecule?

2.2 Single- vs. Mult-Material Printers

hé of | ?
23 Fil Formats Used in 3D Printing O better, do you have a picture of the model put to good use’
3 Overview of the 3D printing process We would love to know more about it. Please feel free to contribute to this page and share your prints! Note: If editing this page its not for you and you would prefer to focus on 3D
3.1 Preparing the structure and generating a printable File printing, drop us an e-mail at marius.mihasan(@)uaic.fo and we would love to hear your story and share it on this page.
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Asimplified
model of SV40
Capsid

Model of SV40 Capsid printed on multi-material printer (Bambulab A1 Mini). Printable
il Printables.com 8. the Proteopedia Print3D tool from
SV40_Capsid_Simplified. Printed by Marius Mihasan 12:27, 8 October 2025 (UTC).

Proteopedia and 3D Printing

Physical molacuta madei, by engaging both visualand tactle senses, provide n eflecive mean of despening the undersianding o complex concapts n moleculr iokogy and
biochemistry. They allow students to perceive the thereby the and
function "] 2], Numerous smases have osmmsualod that the use of tangible models in science education improves leaming outcomes, fosters conceptual reasoning, anc

student 1148 of 3D-printing. has made it possibl and affordable molecular models i"l e,
Affordable deskiop 3D printers can now be used to fabricate physical models from virtually any structure or scene on Proteopedia. This page provides an introduction to 3D
printing, a step-by-step guide g printable files directly spedia, and several tested printing profiles for common printers (e.g., Prusa Research, Bamby Lab,
Creality, or Elegoo).
Let's 3D-print the whole Proteopedial

Trace Model of the GABAA receptor 6x3x printed on a single material FOM-Printer
(Prusa MK3S+). Each of the 5 subunits was printed separately and can be assembled.
Printable files available on Printables.com 4. Printed by Marius Mihasan 12:27, 8
October 2025 (UTC)

«3D Printing 101»: an introduction to 3D printing receptor

3D printing, also known as builds physical objects layer by layer from digital designs. For more technical details please head for the excellent introductory
article on AI3DP 4. In structural biology education, 3D printing provides an affordable and accessible way to transform atomic coordinate data (e.g., from PDB, MOL or SDF files)
into tangible molecular models that can be observed, handled, and discussed in class or laboratory settings.

Printer Types: FDM vs. SLA/DLP

The two most accessible 3D-printing technologies that can be used to create molecular models are:
« FDM (Fused Deposition Modeling) (GABAA recepior, 6x3x

This method extrudes a heated thermoplastic filament (such as PLA, PETG or TPU) through a fine nozzle, depositing successive layers that form the model. FOM printers have

the advantages of low cost, easy maintenance, wide availability, and being capable of printing large and colorful molecular models. This technology has a few limitations, such as:

visible layer lines, lower surface resolution, and less suited for very small or intricate molecular details. Let's 3D-print the whole Proteopedial
= SLA/DLP (Resin Printing)

This technique uses liquid photopolymer resin, cured layer by layer with ultraviolet light. SLA/DLP printers have the advantages of a very high resolution, smooth surfaces and are

ideal for compact and detailed models (e.g., small proteins rendered as surface, ligands, or symmetric assemblies). This technology has its own limitations, such as higher

material cost, post-processing requirements (washing and UV-curing), and the need for careful handiing of resin.

When choosing between FDM and SLA printers, model size and resolution are the key criteria: FDM is preferred for large, educational display models; SLA/DLP is optimal for

small, precise structures.

Model 3 Image with model 3 Description of model 3

Proteopedia Page Contributors and Editors (what is this?)

Marius Minasan

Category: 3D printer files

While FOM and SLA/DLP are the most widely used technologies in educational and due to their other addt s

such as Selective Laser Sintering (SLS), PolyJet, and Binder Jetting— each employing different materials and curing isms. These i tech produce avigation

highly detailed or multi ! parts but are generally and s acosssible for lassroom use. For an overview of mejor 30-printing technologies, see AISDP « Main Page

Complete Overview of the Types of 3D Printers 3 » Table of Contents
= Structure Index

Single- vs. Multi-Material Printers « Random

Maost entry-level desktop 3D printers use a single filament of resin, producing models in one color or material. However, mult-material systems (such as Bambu Lab AMS & and S oo Corions

« Ho
its variants or Prusa MMU3 £ ) can simultaneously print multple filaments, enabling color-coded domains, subunits, or igands directly in one print. For complex color information, i
users can also apply post-print color coding (painting or labeling) or print separate parts and assemble them manually.
iarch
Alarge FOM-printed model A multi-material FOM-printed model
Go | | Search
oolbox

= What inks here
= Related changes.
* Upload fie

« Special pages

= Printable version
« Permanent link
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DNA (left) and insulin (right) models, 4bna and &
4ins, scalo at the botiom in cm
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Bacterial 70S rbosome, 4v5d, scale at the bottom in cm

GABAA receptor, 6x3x, scale at the bottom in cm



Examples of printed models currently used for teaching
*i; - ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW.uaic.ro

Antibodies interacting with an antigen (lysozyme)

Light chains

29.10.2025 3DP-Jmol Slide 44 / 46


https://3dprint.nih.gov/discover/3dpx-015554
https://3dprint.nih.gov/discover/3dpx-015554
https://3dprint.nih.gov/discover/3dpx-015554

Examples of printed models currently used for teaching

*
L?;;if ALEXANDRU IOAN CUZA UNIVERSITY of IASI www.uaic.ro
A protein nanopore sequencing DNA
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Examples of printed models currently used for teaching

ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW. Uaic.ro

Physical model for teachmg lac operon regulatlon
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Examples of printed models currently used for teaching

*
i?;;gj ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWW. uaic.ro
Physical model for teaching lac operon regulatlon

Assembled Lacl n
tetramer

surface representation

Operators
01 and 02

H
PDB IDs: 1lbg; 1run 6b6h 0

QAR i
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Examples of printed models currently used for teaching

*
i?-;;gj ALEXANDRU IOAN CUZA UNIVERSITY of IASI WWw. uaic.ro

Physical model for teaching lac operon regulation

CRP

cartoon representation

Assembled

«— CRP dimer
N ‘ “

Y

CRP site

PDB IDs: 1lbg; 1run; 6b6h
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Feedback and Follow-Up

ALEXANDRU IOAN CUZA UNIVERSITY of IASI

www. uaic.ro
1

e

x,.

Your feedback is extremely valuable in improving future workshops and ensuring that the
3DP-Jmol resources continue to evolve to best serve the educational community.

Please take 2-3 minutes after the session to complete a short, anonymous feedback form:

[E] Feedback Form: https://forms.gle/zUAG9ChebcJdkedP8

(® Estimated time: 2-3 minutes

You may also access the form by scanning the QR code: E

[=].

29.10.2025
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https://forms.gle/zUAG9ChebcJdkedP8
https://forms.gle/zUAG9ChebcJdkedP8
https://forms.gle/zUAG9ChebcJdkedP8
https://forms.gle/zUAG9ChebcJdkedP8
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